
1. Getting Started
Easy Working Labels! 1.0 is a specialized program that simplifies the production of labels and cards, 
and the addressing of envelopes. These processes involve a small amount of text in a complex format a 
task that Easy Working Labels! handles well. In addition, Easy Working Labels! works in conjunction 
with the Address Book and the Database modules to print multiple labels, cards, or envelopes.
With Easy Working Labels! you can:

• Use a standard, preformatted template or customize a template for special envelopes, cards, or 
labels.

• Enter a single name and address or, for large mailings, use names and addresses that are stored in 
the Address Book or a database file to produce labels or envelopes.

• Print envelopes or labels of standard or custom size in any sheet arrangement from the Label 
Maker.

• Save your data definitions for later use and retrieve previously saved data.

The User's Guide is designed to help you get started and acquire the basics of using Easy Working 
Labels! as quickly as possible. It is organized as follows:
"Getting Started," discusses the contents of the Easy Working Labels! package, and includes 
information on typographical conventions used in the User's Guide, how to contact Customer Support, 
how to install Easy Working Labels!, and how to configure your printer.
"The Easy Working Labels! Environment," discusses various aspects of Easy Working Labels!, 
including the elements of a window and how to use a mouse, menus, printing, and the Help feature.
"Tutorial," which provides instructions on using Label Maker, alone or in combination with the Address 
Book and Database.
"The Label Maker," discusses the basics of the Label Maker module. Included is information on the 
elements of the Label Maker window; template and document files; how to create, modify, and save 
templates; how to enter data into a template; how to save data in a document file; and information on 
menus and commands.
"Printing Labels and Envelopes," discusses how to print labels and envelopes. Included is information on
using Label Maker in combination with the Address Book and Database modules.
"The Address Book," describes the parts of the Address Book window; how to add, delete, and manage 
Address Book cards; and how to print an Address Book card.
"The Database," describes the parts of the Database window; how to add, delete, and edit information in 
the Database; as well as other information on managing the information contained in the Database. 

This manual uses the following typographical conventions: 

Italic Text Indicates a title or emphasizes information.
Bold Text Indicates characters you type. For example, "Type a:install and press ENTER" tells you

to type the command, then press the ENTER key.
CTRL Key names are always shown in capital letters.
+ A plus sign specifies keys that you should press simultaneously. For example, ALT+F 

means you should hold down the ALT key and press the F key.

This section is designed to help you install and configure Easy Working Labels!. Before you begin the 
installation process, please read through the following system requirements.

• Windows Version 3.1 or 3.0
• Easy Working Labels! is optimized for Windows 3.1; illustrations or examples in this manual 

reflect this compatibility. Users of Windows 3.0 may notice slight differences in screen and screen 
images presented in the manual and must use a different means to setup printers. 

• MS-DOS version 3.0 or later
• A personal computer with an 80486, 80386, or 80286 processor capable of running Windows in 

Standard or 386 Enhanced mode



• 2 MB or more of memory
• A hard disk with at least 2 MB of unused space
• A 1.2 MB, 5.25 in. or 720K (or 1.44 MB) 3.5 in. disk drive
• A properly installed mouse
• A display adapter and monitor that are supported by Windows

The following procedure assumes that you have some familiarity with Windows and are using a mouse. 
If you need help, see Chapter 2, "Working with Easy Working Labels! Environment," as well as your 
Windows documentation.

The installation procedure has two sections:
1. Installing Easy Working Labels!
2. Using the Windows Control Panel to select a printer

To install Easy Working Labels!:

1. Please refer to the section titled "INSTALLATION" for complete program setup instructions. After
completing those instructions, follow the procedure below.

2. The Easy Working Labels! Install dialog box appears.
3. Turn on the Modify AUTOEXEC.BAT check box if you want to add Easy Working Labels! to 

the path in your AUTOEXEC.BAT file. (An X appears in the check box when you turn the option 
on.)

4. Click on OK.
As the installation process continues, the program instructs you to insert the proper disks. When 
installation is complete, you receive the message "Easy Working Labels! has been successfully 
installed." 

5. Click on OK.
The installation program notifies you when it successfully completes the installation. You should 
now select a printer by opening Easy Working Labels!. 

Double-click on the Easy Working Labels! icon. 
An empty label template screen appears with icons for the Address Book and Database modules at the 
bottom of the screen.
NOTE: If the icon is not visible, you should minimize Program Manager to make the entire Easy 
Working Labels! window visible.

Before you start creating and printing labels, you need to give Easy Working Labels! information about 
your printer. You may have more than one printer installed, and the program allows you to select any of 
those printers. 

To configure a printer:

1. Select Printer Setup... from the File menu.
The Printer Setup dialog box appears.

2. Highlight a printer from the list of installed printers.
If there is a scroll bar, use it to view additional printers. 
If the printer you want to use is not in the list, see the section "Printing," in Chapter 2, for more 
information.

3. Click on OK. 
The printer you highlighted is selected and the label template window returns.
You can change the choice of printer as often as you wish by repeating these steps. You can select 
the Printer Setup... command from either program module. 

If you are familiar with Windows applications, you can move ahead to the Tutorial in Chapter 3 and the 



subsequent reference chapters. If you are less familiar with Windows, Chapter 2, "The Easy Working 
Labels! Environment," provides an overview of basic Windows concepts to make working with Easy 
Working Labels! easy and effective.

2. The Easy Working Labels! Environment
If you're new to Microsoft Windows or Easy Working Labels!, read this chapter as your starting point. It
explains the basic concepts and techniques that you need to work with Windows and Easy Working 
Labels!.

The first section, "Working with Windows," explores the Microsoft Windows environment. You will 
learn:

• How to use a mouse
• About the Windows desktop
• How to use scroll bars
• How to use menus and other Windows commands
• How to select or install printers

The "Easy Working Labels! Basics" section familiarizes you with Easy Working Labels!, and explains 
basic tasks and functions that are standard for all modules.

You will learn how to:

• Load Easy Working Labels!
• Navigate through Easy Working Labels! menus
• Configure Easy Working Labels!
• Use the Help system
• Use the QuickButton palette 

The Windows environment is a powerful tool that simplifies using a computer. Windows provides a 
standard set of computing tools that can be found in every Windows application. The following sections 
provide an overview of the Windows environment. For more information on a Windows topic, refer to 
your Microsoft Windows documentation.

Most users operate Windows and Easy Working Labels! functions with a mouse. This manual describes 
most operations with mouse commands. A mouse is a small, handheld device that you move around on 
your desktop or mousepad to manipulate a pointer on the screen. Although most mice have multiple 
buttons, for most applications you need only the left. You can also use your keyboard to perform most 
functions.

If you are a new mouse user, there are a few terms that you should know. When the manual says to:

Point — Move the mouse until the pointer touches a character, menu item, icon, button, and so on.
Click — Point to the item, then press and release the left mouse button. This is how you select menu 
items, position the cursor, and perform many other functions.
Double-click — Point to the item, then press and release the left button twice. This selects an item and 
executes a command. An hourglass often appears on screen indicating that the computer is processing 
your command. If you have difficulty double-clicking quickly enough, consult your mouse manual.
Drag — Point to an item, press and hold the left button down as you move the mouse. This is how you 
resize windows, highlight text, and perform a variety of other functions.



The mouse pointer changes its shape and form according to its position on the screen and the active 
function. 

All activities in Windows occur on the Windows desktop. It becomes your electronic workspace, much as
your physical desktop is your office workspace. You can perform a variety of tasks with the icons 
(symbols) on your Windows desktop. You can move them around, start new projects, and remove 
completed tasks.

There are two types of windows: application windows and document windows. All windows have 
common elements, although not all windows contain every element. Regardless of the Windows 
application that you use, there are certain elements that always behave in the same manner.

Title Bar — Appears at the top of an application window and at the top of document windows. The title 
bar displays information about the current application or file that is contained in the window. 
More than one window can be open at a time. The one in which you are working is known as the active 
window. The title bar of the active window is shaded differently to distinguish it from other open 
windows.

Control-Menu Box — Governs the appearance of the selected window. You can move, resize, minimize, 
maximize, close, and select the active window. You can carry out each activity with mouse actions.

Menu Bar — Contains the available menus for the active window. Virtually all Windows applications 
have File, Edit, and Help menus.

Minimize/Maximize/Restore Buttons — Allow you to control the size of the active window without 
opening the Control menu.

The Minimize button reduces the window to an icon on the desktop. The Maximize button expands the 
window to fill the available space. If you maximize an application window, the window fills the desktop 
(the entire screen). If you maximize a document window, the window expands to fill the application's 
workspace.

Once you maximize a window, the Maximize button becomes a Restore button. Clicking on Restore 
returns the window to its previous size.

Control Strip — Contains buttons that quickly access the most commonly used commands. These 
commands are duplicated on the menus.

Workspace — Designated area for displaying work. For some applications, you work directly in the 
workspace; for others, you open document windows within the workspace.

Window Border — Defines the frame of a window. You can resize a window horizontally or vertically by
dragging the appropriate side of its frame to a new position.

Window Corner — Drag a window corner diagonally to resize two sides of a window simultaneously.

Scroll Bars — Appear along the right and bottom of an application or document window when the 
contents exceed the size of the window, allowing you to view information hidden outside the borders of 
the current window.

I-Beam Cursor — Indicates your current position in the open file. Generally, this cursor indicates where 
text will be inserted or corrections will be made.

Mouse Pointer — Used to position cursors, and select and move objects in the Windows environment.



Scroll bars let you move through a document or application window when you cannot view all 
information on a single screen. Use the scroll bar at the right side of the window to move line by line or 
screen by screen through a document. Use the horizontal scroll bar at the bottom of the window to scroll 
from side to side.

Although each module contains different menus and commands, the manner in which you select a 
command is consistent throughout all modules. Windows uses menus and dialog boxes, as well as key 
strokes, to help you perform operations and functions.

To select a menu item:
1. Point to a item on the menu bar and click.
2. The menu appears, showing a list of the menu commands.
3. Point to and click on your selection. This activates the command.

Commands that are followed by an ellipsis (...) require more information, and cause a dialog box to 
appear. Other commands activate immediately. If you find that a command is gray, you are not in the 
mode in which the command can be used. 

In addition, notice that there are keyboard shortcut designations after the menu command. You can use 
these key combinations to activate the command if you prefer. The commands that are common 
throughout all modules, such as the Print... command always use the same shortcut.

Working Labels! uses dialog boxes to communicate with you. A dialog box is displayed on the screen 
when Easy Working Labels! requires specific information in order to complete a command or to verify 
your request. Dialog boxes contain one or more information fields, which you can move among by using 
the TAB key or by pointing with your mouse to complete the requested information. The current or 
default options are highlighted or marked by a dotted rectangle.

Text Box — Click on the text box (or press TAB) to place the cursor in the text box; then, enter the 
proper information.

Option Button — Click on one member of the Option Button group to make your choice. You can select 
only one button at a time.

Check Box — Click on a check box to toggle it on and off. An "X" in the check box indicates that the 
option is selected.

OK Button — Click here to activate the dialog box selections.

Cancel Button — Click here to exit the dialog box without activating your selections. 



The Connect Dialog Box 

List Box — Click on the DOWN arrow to display a list of available choices. Use the scroll bar to view 
additional list box selections. Then, double-click on an item to select it.

Command Button With Ellipsis — If you click on a command button that is followed by an ellipsis, 
another dialog box appears requesting additional information

Easy Working Labels! uses the Windows Control Panel to print information. Using the Control Panel, 
you can customize many aspects of your system — from screen colors to printer fonts.
Use the Control Panel to install and configure printers; to set a default printer port; to select paper size 
and orientation; and to determine the graphic quality of your output.

When you install Windows for the first time, the Windows Setup program starts the Control Panel and 
lets you configure your printer. You can return to the Control Panel at any time to modify your printer 
selections. You will need your Windows program disks to install additional printers.

The following information describes printer configuration for Windows 3.1. If you use Windows 3.0, or 
if you need additional information, consult your Windows documentation. 

To select and configure a printer:

1. Open the Windows Control Panel located in the Main Programs Group, and double-click on the 
printers icon.
The Printers dialog box appears.
The list box shows all of the installed printers. Your screen may differ, depending upon which 
printers you have installed.

2. Highlight the printer you want to use.
3. To change the printer connection port, click on the Connect... command.

The Connect dialog box appears.
4. Select the communications port that your printer uses from the Ports list box.

Scroll through the list to see additional choices.
5. Click on OK.

The Printers dialog box returns.
6. Click on Setup... to change the printer configuration. 

The Printers dialog box appears.
7. Choose the settings that you want to use from the dialog box.
8. Click on Options... to choose additional options for your printer.



NOTE: Depending on the selected printer, the Options command may not be available.

9. Choose the options appropriate to your needs and click on OK.
The Printer setup dialog box returns.

10. Click on OK.
The Printers dialog box returns.

11. Click on Set as Default Printer, or press ALT+E.
12. Click on Close to exit.

You return to the Control Panel. 

Each Easy Working Labels! module includes a Help menu on the menu bar. The Help system provides 
a quick, online reference to Easy Working Labels! menus, features, and commands.

To access Help:

1. Select the Help menu.
The Help menu appears.

2. Select the appropriate Help command from the following table:

Command Descriptions 

Index Displays the Help window with Easy Working Labels! Help index as the 
current selection.

Active Module Displays the Help window with an index for the current module and its Help 
index active.

Commands Displays the Help window with a listing of menus for the current module.
Keyboard Displays the Help window with an index to keys used in the current module.
Using Help Displays the Help window with the section on using the Help system active. 
About... Displays a dialog box with information about Easy Working Labels! 

development. 

When you make a selection, a Help window appears.
Contents button Displays the Easy Working Labels! Help Index.
Search button Displays a dialog box that you can use to search Help topics.
Back button Select this button or press ALT+B to make the last Help screen that was 
viewed current.
History button  Displays a dialog box that shows all recent Help screens. You can select one 

and double-click to make it active.
Browse Arrow buttons Allow you to page forward and backward through Help pages.

3. To exit help, exit from the File menu on the Help screen, or press ALT+F4.

You can access the Help window quickly by pressing F1. When you press F1, Easy Working Labels! 
displays information about the current module in the Help window.

The Help system uses the following conventions:

• For "underlined words," click on the topic for which you want more information. At the next 
screen, TAB to the selection and press ENTER. Select the Back button to return to the previous 
Help screen.

• For "dot-underlined words," click on the word for a definition, or TAB to selection and press 



ENTER. Press ENTER again to hide the definition. 

To make your work quicker and more convenient, Easy Working Labels! provides you with a collection
of icons that you can display together on Easy Working Labels!' QuickButton palette.
The QuickButton palette groups the commands that you use most often into a single, floating box that 
you can position anywhere on your screen. To choose a command from the palette, you simply click on 
its icon.
You can keep the palette on screen or hide it until needed.

To access the QuickButton palette:
1. Select the QuickButton palette command from the Window menu.

The QuickButton palette appears.

At first, the QuickButton palette is displayed in the bottom, righthand corner of the screen.

                                                

QuickButton Palette

2. Position the QuickButton palette on your desktop by clicking and dragging its title bar.
3. Resize the QuickButton palette by clicking and dragging on any of the sides or corner handles.

When you resize the QuickButton palette, the icons are rearranged automatically to fit the new size.

The commands that are available with the QuickButton palette change with the different modules in 
which you use it. A list of commands for each module appears in the Configure dialog box described 
below. You can reduce the size of the palette by deselecting commands that you do not use often.

To customize the QuickButton Palette:

1. Open the Easy Working Labels! module for which you want to set up a QuickButton palette.
2. Select the QuickButton palette command from the Windows menu.

The QuickButton palette appears.
3. Double-click on the QuickButton palette title bar, or select the Configure... command from the 

QuickButton palette control box menu.
The Configure dialog box appears.

4. Select a command from the list box.
You can scroll through the list to see additional commands.

5. Click on the Add or Remove button to add or remove the highlighted command.
The icon for the command appears immediately, or is removed from the QuickButton palette.
You can quickly add or remove all commands from the palette by clicking on Add All or Remove 
All.

6. Click on Close. The new palette remains in effect until you reconfigure it.
The QuickButton palette changes automatically as you change modules.
With each module you can have a different set of commands and locations to keep the 
QuickButton Palette.

To put the QuickButton Palette in a location on screen:

1. Select the Keep command from the QuickButton palette control box menu.



Options for locations appear in an extended menu.
2. Select one of the options: Left, Right, Top or Bottom.

NOTE: You can hide the QuickButton palette by selecting the Hide command from the palette's control 
box menu.

The next chapter  is a tutorial that guides you through most of the Easy Working Labels! modules, and 
gives you step-by-step instructions for using many of the commands and features. You can read the 
tutorial in its entirety, or look at individual modules. 

3. Tutorial
This tutorial is designed to give you broad exposure to Easy Working Labels! and its key functions. 
Easy Working Labels! is a package of three common user applications including the Address Book, the 
Database, and the Label Maker. These applications can be used in two ways: in conjunction with each 
other for printing labels and rotary cards, addressing envelopes, and producing mass mailings using 
database records; or as individual software modules for specific tasks.
The aim of this tutorial is to teach you some of the functions of the modules, and to expose you to the 
power of using Easy Working Labels!.
The lessons that follows will be easier to complete if you have already familiarized yourself with the 
basics of Easy Working Labels! and Windows, as given in Chapter 2, "The Easy Working Labels! 
Environment." If you haven't already done so, we recommend that you thoroughly read that chapter 
before beginning the tutorial.
The Easy Working Labels! tutorial leads you through preparing and producing customized labels, cards, 
and envelopes for each person on a distribution list by accessing names, addresses, and other information
from a database.
The tutorial should take approximately 20 minutes, but we suggest that you go through it at a 
comfortable pace. If you need more information after completing a particular part of the lesson, go to the 
appropriate chapter and look for specific topics and detailed procedures. 

This tutorial directs you to open and use some sample files that are provided with your Easy Working 
Labels! software package. We suggest you save these files under different names so that you will always 
have them should you wish to repeat the lessons. In each case, instructions on how to do this are 
provided.

The Easy Working Labels! Database lets you store and organize records of many types customer lists, 
inventories, promotional mailing lists, accounts receivable, even recipes. You can view the data, sort it, 
select certain records, and generate reports.

In this lesson, you will open an existing sample database of people in a company. You will update the 
format and content of this database, add records to it, and select a customized list of people who are to 
receive your report.

To open the Database:

1. Select Database from the Window menu.
Easy Working Labels! opens the Database module.
The message "No Database Open" appears in the middle of the workspace, prompting you to open
an existing database or create a new one. Before you begin, maximize the Database window, if 
you like, by clicking on the UP Arrow button located on the far right of the Database's title bar.

2. Select the Open... command from the File menu. 



The Open Database dialog box appears.
3. Double-click on SAMPLE.WDF from the list in File Name text box.

The Database opens the sample file in the Edit Records mode.

When a database is first opened, the default view is Edit Records mode, which allows you to view and 
edit a single record in the database. All text entry and editing occurs in this mode. 
Change to the other primary view, the List view, by clicking on the List View button on the control strip.
In List mode, the field names are displayed across the top of the screen. Most of the fields are off the 
screen to the right; display them by using the horizontal scroll bar at the bottom of the screen. In this 
mode, which displays part of twenty or more records at a time, it is easier to find, sort, and select records 
to edit, or to be part of a special subset (e.g., for a mailing).
If your database contains more records than can be displayed on the screen, use the vertical scroll bar to 
browse through the list of records.

To change an Easy Working Labels! Database, you can add to and delete records from it, and also 
change the structure of the database, as shown in this lesson. 

This sample database is incomplete. You are going to add a field to this database before we enter any 
additional records.

To add a field to the Database:

1. Select the Alter command from the Database menu.
The Database switches to Definition mode, which enables you to create, delete, position, and 
name database fields.

2. Click on the Text button on the control strip (the one with a large T on it).
The cursor changes to an I-beam.

3. Click anywhere in the Database window workspace.
The Define Text dialog box appears.
In the text box, enter text to serve as a screen display label for a database field.

4. Enter Title: as the name for the new field and click on OK.
The word "Title:" appears on the workspace and the cursor returns to a normal pointer.

5. Click in the middle of the label and hold the left mouse button down. Selection handles appear and
you can move the text label.

6. Position the text label appropriately under the other labels and fields.
7. Click on the Create Fields button on the control strip.

The cursor changes into a crosshair.
8. Click in the workspace next to the Title: label. 

The Define Field dialog box appears.
9. Enter a Field Name for the field such as TITLE.

NOTE: The database identifies fields by their field name, not by their text label. You should select a field
name that is descriptive of the field's data. To simplify matters, you can make the field name and the text 
label identical.

10. Use the TAB key to move to the Field size text box and increase the number to 30.
11. Click on OK.

Easy Working Labels! places a box with the name "TITLE" inside it on the workspace.
12. Position the field to the right of its text label.

You position fields the same way you positioned the text label.
13. Select the Edit Records command from the Database menu, or click on the Edit Records button on

the control strip.
The Database Definition dialog box appears and prompts you to save the new database definition.

14. Click on Yes.
The new database definition is saved and the Database module returns to Edit Records mode so 



you can start entering data.

When you return to Edit Record mode, the label and field you added are included. Before you begin 
entering information, experiment with the control buttons to move around the database in Edit Records 
mode. 

Press the First, Previous, Next, and Last buttons on the control strip, or use the commands on the Record
menu to work your way around.

To enter records into the Database:

1. Click on the First Record button on the control strip.
Easy Working Labels! displays the first record in the sample database, which is the first President
of the United States, George Washington.

2. Click on the Title field.
A text cursor (one that looks like an I-beam) appears in the field.

3. Enter Past President in the field.
4. Click on the New button on the control strip.

Easy Working Labels! presents a blank record card with the text cursor in the first field.
5. Enter your name, department, and title.
6. Click on the New button to record your name in the database and present a fresh, new card for 

another entry.
7. Make a couple of other entries of friends, and coworkers that you can easily remember later.

To remove records from the Database:

1. Select the Find Record... command from the Record menu.
The Find Record dialog box appears.

2. Click on the LNAME field name.
The field name is highlighted.

3. Enter Hawkins in the text box and press the ENTER key.
Easy Working Labels! finds the first listing of Hawkins in the database.

4. If this is not John Hawkins, click on the Find Next button until you find John Hawkins.
5. Once you are viewing the record that you want to delete (the one for John Hawkins), select the 

Remove Record command from the Record menu.
The Database prompts you to confirm your desire to delete the record.

6. Click on Yes to delete the record.
To produce the mailing, we will work from Easy Working Labels! and merge the information 
from this database and print labels, cards, or envelopes.

So far in this lesson you have learned to open the Easy Working Labels! Database module, adjust the 
definition of a database, and add and delete records from the database.
There are many more options and functions available to help you tailor databases to your specific needs. 
Be sure to read the Chapter, "The Database," for detailed information on this module.

In this lesson, you will use Label Maker to address envelopes for mailing your report and cover letters. 
Label Maker makes printing envelopes easy by providing templates, or pre-designed forms, for you to 
use. These templates are for common label and envelope sizes and layouts, as well as for rotary-file 
cards. Furthermore, you can customize the templates to use any combination of fields that exist in your 
Address Book database. That is, you can include (or omit) honorifics, company names and titles, 9-digit 
ZIP codes, and so forth. 

To open Label Maker and a new template:

1. Select the Easy Working Labels! command from the Window menu.



The Label Maker window appears. The window contains a general Label Maker template; we 
want to use a different one.

2. Select the Open... command from the File menu.
This dialog box allows you to select the appropriate label/envelope format.

3. Select Tutorial (this is set up for standard #10 business envelopes).
Check your printer's ability to handle envelopes, particularly the limits of size and weight, before 
you try to print.

4. Click on OK.
The Envelope entry screen appears with a (From:) set of text boxes and a (To:) set of text boxes.

5. Enter your name and address in the (From:) text boxes.
This is the return address portion of the envelope. 

Rather than type in a (To:) name and address yourself, you want to use an Address Book database named 
SRMCMT to provide the data. 

To open (set) the correct database:

1. Click on the DB button on the control strip.
The Set Database dialog box appears.

2. Select the SRMCMT database.
3. Click on OK.

The Address Book contains data you don't necessarily want to use in a mailing label, such as telephone 
numbers and salutations. These steps allow you to select only the database fields you want for the 
address portion of the envelope.

To set the print merge fields:

1. Position the cursor in the (To:) text box in which you want to enter information.
2. Click on the Insert button on the control strip to display the Merge Field dialog box.
3. Select a Merge Field field and click on OK (or double-click the Merge Field name).

The first field you choose can be an honorific (Mr., Mrs., etc.) if your database has them, or can be
simply the name of the addressee.

4. Position the cursor again and choose the next field. 
5. When the field designators are entered in the text box, make sure that there is proper spacing or 

punctuation around them that is appropriate for mailing.
For instance, if you want to include both a title and a company name on the same line ("President, 
Allied Trucking Co."), insert a comma and a single space between the fields in the To: text box.

6. Insert all the fields needed for the address.
7. Make other adjustments as necessary:

a. Select a font and size from the selection boxes on the control 
strip. You won't see the typefaces and sizes change on screen, but Easy Working Labels! will 
apply your choices to the envelopes when they are printed.
b. Click on the Envelope Layout button on the control strip to display the Envelope Layout 
dialog box. Confirm the information about envelope size and so on that has been entered as a 
standard for a business envelope size. Because of the type style and size you have chosen, you 
may prefer to make some adjustments.

Now you are ready to print envelopes, that is, if your printer is set up to handle envelopes in either a 
manual feed or tray feed mode. Consult your printer documentation and your Windows documentation 
for advice on set up for printing envelopes.

11. Click on the Print button on the control strip.
The Print dialog box appears.

12. Click on OK.
Easy Working Labels! begins printing envelopes.



You are ready to mail your report in custom-printed envelopes. You need only to collate, fold, stuff, and 
stamp. 
You should be more comfortable now with using the modules. Be sure to explore the Chapters 4 through 
7 for additional information on how to get the most from Easy Working Labels!. 

4. The Label Maker
This chapter discusses the basic concepts of the Label Maker module, including a discussion of the Label
Maker window, and template and document files; creating, modifying, and saving templates; entering 
data into a template; saving data to a document file, and the menus and commands that are available to 
you.

The Label Maker window displays either the label or the envelope data entry format, based on the last 
document that was created with the module.
To open the Label Maker:

1. Start Windows if it is not already active.
2. Double-click on the Label Maker icon. 
One of the Label Maker windows appears containing the following:

Title Bar — Displays the module name.
Menu Bar — Provides access to the Label Maker menus and commands.
Control Strip — Streamlines access to the most frequently used Label Maker commands.
Status Bar — Displays the active mode (Label, Envelope, or Card), the document or template name, the 
filename, and the selected database.

Label Maker has two operating modes: Normal and Preview. The first, Normal mode, is used to create 
templates, or document files for output. The second, Preview mode, is used to view the output, complete 
with formatting, prior to printing. 

The buttons on the Normal mode control strip allow you to quickly execute common commands.

The Normal Mode Control Strip

Font and Size List Boxes — List the available fonts and point sizes. You can use only one font and point 
size per line in your labels, cards, and envelopes, but you can use a different font and point size on each 
line.
Layout Button — Allows you to enter margins and label, card, or envelope dimensions.
DB Button — Allows you to select a database for a print merge.
Insert Button — Inserts a field name from the selected database for a print merge.
Print Button — Allows you to print individual labels, envelopes, or cards, or begin a print merge.
Preview — Allows you to view the envelope, card, or label layout before it prints.

The Preview mode control strip has the following buttons:



The Preview Mode Control Strip

Print Button — Allows you to print individual labels, cards, or envelopes, or begin a print merge.
Zoom In Button — Displays a single label, card, or envelope.
Zoom Out Button — Displays the entire label page, card, or envelope.
Edit Button — Switches to Normal mode. 

The Label Maker module contains predefined label, envelope, and rotary card template files that contain 
layout information. These templates include the necessary information — size, shape, and so on — for 
making the automated processing of address data quick and easy using a wide range of available label 
products and envelope sizes.
This information is stored in two types of files: template files and document files. Each of these is 
discussed in the following sections.

Template files define how address information will appear when it is printed. These files contains all of 
the information necessary for arranging the information in a particular format. For example, one template
might allow you to print a simple business envelope; another will print 30 addresses on a sheet of labels 
that is arranged in three columns of ten rows.
The predefined templates are listed in the New dialog box. You can pick any of these templates, if one 
fits your needs. In addition, you can modify these templates to create other formats.

Document files contain both layout and data for a particular mailing. When you save both the layout and 
the data (including merge field references) in a single file, you can produce multiple copies of the same 
data quickly and easily.

There are two types of templates: label templates and envelope templates. The first step in any Easy 
Working Labels! project is to choose a template and modify it, if necessary. The data entry screen that 
you complete depends on the type of template you choose. 

If you select a label template, Label Maker displays the label entry form, which contains ten lines in 
which you can enter data for labels. The data you enter can be text or merge fields, as described later in 
this chapter.

If you select an envelope template, Label Maker displays the envelope entry form, which contains four 
lines for return address (From:) data and four lines for the recipient address (To:) data. 
The return and recipient address data can be text or merge fields, as described later in this chapter.

To choose a template:

1. Select the New command from the File menu.
The New File dialog box appears.

2. Choose an existing template from the list.
Check the Preview Template option to view a thumbnail sketch of the label or envelope layout.

3. To save the selected template as the default template, select the Save Default button.
4. Click on OK.

The entry screen for the selected template is displayed.

If the layout of the template does not meet your exact needs, you can either create a new template or 
modify an existing one. Starting from an existing template is quicker and easier, so browse through the 
preexisting templates before trying to start from scratch.

To modify or create a template:

1. Open a template that is the type (label or envelope) you want to create.



2. Click on the Layout button or select the Layout command from the Labels menu.
The appropriate Layout dialog box appears.

3. Edit the fields that define the size, margins, and, if necessary, label arrangement.
Envelope — Defines the size of the envelope and margins for each address area.
Label — Defines the label's position, dimensions, the number of rows and columns on the sheet, 
and the spacing between rows and columns.

4. Click on OK.
5. To modify the fonts used, place the cursor on the line in which you want to change a font.
6. Select the Character... command from the Format menu.

The Character dialog box appears.
Alternatively, you can use the Font and Size list boxes on the control strip to change a font or its 
size. Remember, you can use only one font and point size per line.

7. Select a font, style, and size to use on the current line and click on OK.

Now, you can preview the modifications or save the new layout information as a template file. 
Alternatively, you can enter text and save the file as a document. (This process is explained in detail later 
in this chapter in the Saving Data in a Document File section.)

To preview a template:

1. With a template open, click on the Preview button or select the Print Preview command from the 
File menu.
The Print Preview dialog box appears.

2. Click on OK.
The Print Preview screen with the current label or envelope data is displayed.
From this screen, you can "zoom in" to view a single label or envelope, or "zoom out" to preview 
a sheet of labels or the entire envelope. 

3. Click on the Zoom In button to see a single label or the recipient address for an envelope.
4. Click on the Zoom Out button to see a whole page of labels or a complete envelope.
5. Click on the Edit button to return to the label layout or envelope layout window.

After you have altered the format, you can save the current settings as a template.

To save a template:

1. Select the Save As... command from the File menu.
The Save As dialog box appears.

2. Select Template (.LBT) from the List Files of Type list box.
3. Enter a filename for the new or edited template in the File Name text box. Label Maker 

automatically attaches the (.LBT) extension.
If this is an update to an existing template, or if you entered a name that has already been used, 
Label Maker asks if you want to overwrite the template.

4. Click on OK.
Label Maker saves the template.

The new layout is now available for you to use as a template. To use the "new" template, select the New...
command from the File menu and select the template from the list box.

The data for a label or envelope can be text that you enter directly, merge fields from a database, or a 
combination of both. 

If you are printing only one label or envelope, the data should be entered directly.

To enter a single address:



1. Open an existing document file or select a template.
Check that the layout and font selections are correct.

2. Enter the address information into the appropriate fields.
Envelopes have a return address as the first four lines and the recipient address as the second four 
lines. For labels, you can enter up to ten lines of data.
You can use the standard Edit menu commands Copy, Cut, and Paste to move field information 
into your label from any other Easy Working Labels! applications, such as the Address Book and 
the Database.

3. Use the TAB, SHIFT+TAB, ENTER or UP and DOWN keys to move between fields.
4. Repeat these steps until you fill in all necessary fields.
5. Either save the entry as a document file or print the label or envelope.

While you cannot create a database of names and addresses with Label Maker itself, you can print 
multiple envelopes or labels using data from the Database or Address Book. This is often called a print 
merge, since it involves merging data from another source and formatting it in Label Maker. The most 
common source for data is the Address Book, but Label Maker can accept input from four different kinds
of data files:

• The Address Book data file (.ADF)
• An Easy Working Labels! Database file (.WDF)
• A standard database file (.DBF)
• A comma-separated ASCII data file (.CSV) 

To select a database file:

1. Open an existing document file or select a new template.
2. Click on the DB button or select the Set Database... command from the Options menu.

The Set Database dialog box appears.
3. Select the database type from the List Files of Type drop-down list box.
4. Select the database file from the File Name list box.

Use the directory and drive list boxes to browse through your files.
5. Click on OK.

After you select a database file, you can merge fields in your data entry text boxes.

To enter data for a multiple print:

1. Click in the appropriate data entry text box.
2. Enter text or merge field references.

To insert merge fields:

1. With the cursor positioned in the appropriate field, click on the Insert button or select the Insert 
Field... command from the Options menu.
The Merge Field dialog box appears.

2. Select a Merge Field from the Merge Field list box.

NOTE: If the file is a database file, the field names were defined when you created the database. If the 
file is a .CSV file, the fields have sequence numbers only, not names. Therefore, you must know the 
sequence of data in the fields.

3. Click on OK.

Label Maker inserts a merge field reference, enclosed in curly brackets, at the cursor location. 
Continue entering text and inserting fields until you fill all necessary fields. Then, either save the entries 
as a document file or print the label or envelope. See Chapter 5 for more information on printing labels 



and envelopes.

If you directly enter data for a label or an envelope, you can edit it as you would any other text in a 
Windows application.
Use the standard Cut, Copy, and Paste commands to edit field information with the help of the Windows 
Clipboard. The Delete command deletes selected text without putting it in the Clipboard. This is 
convenient if you want to remove a block of text without losing what you already have in the Clipboard.
Use the Undo command to undelete text removed with the Delete command. However, you must use the 
Undo command before performing any other editing.
Use the TAB, SHIFT+TAB, ENTER, and arrow keys to move between fields.
Use the DELETE and BACKSPACE keys to delete selected text instead of the Delete command.

There is no difference between saving a multiple-print document and saving a single-print document 
(described above). Label Maker saves both the merge field references and the text.

To save data as a document file:

1. When a data entry screen is complete, select the Save As... command from the File menu.
The Save As dialog box appears.

2. Enter a filename for the document in the File Name text box, and designate a storage location for 
the file using the Directories and Drives list boxes.

3. Select Label Maker File (*.LBJ) from the List Files of Type drop-down list box.
4. Click on OK.

You can load document files by selecting the Open... command from the File menu.

When you modify an existing data or format document, you can use the Save command on the File menu
to save your changes and replace the previous version of the document file.

When files become obsolete, you can quickly remove them from Label Maker. When you do this, be sure
you are deleting the exact file you intend; there is no Undo or Undelete command available.
To delete a file:

1. Select the Delete command from the File menu.
The Delete File dialog box appears.

2. Choose a file from the list.
Document files have the extension .LBJ. Template files have the extension .LBT.

3. Click on OK.
The Delete File query box appears, giving you one last chance to change your mind.

4. Click on Yes to delete the file, or on No if you change your mind.

With this basic information for the Label Maker module in hand, you are prepared for the last three 
chapters, which describe how to print cards and envelopes, how the Address Book works to help organize
rolodex information, and how the Database helps manage your information. 

5. Printing Labels and Envelopes
Easy Working Labels! allows allows you to print labels and envelopes using data entered entirely in the 
Label Maker module. It also allows you to perform these same print functions using the data that is 
stored in the Address Book and Database modules.
This chapter describes procedures necessary to print labels, cards, and envelopes using all of the Easy 
Working Labels! modules. For more detailed information on using the Address Book and Database 



modules, refer to Chapters titled  "The Address Book" and "The Database".

Before printing, make sure that you have the:

• Layout and data ready, as described in Chapter 4, "The Label Maker."
• Records selected or record numbers identified if you plan to print only select records.
• Printer selected and set up as needed for your print job.

Use the Label Maker to easily format and print a single envelope or label with data you enter on the spot.

To enter the data:

1. Confirm that you have the correct template open in Label Maker.
2. Type the return address and name and address as you want them to appear.

To set up your printer:

1. Select the Printer Setup... command from the File menu.
The Printer Setup dialog box appears.

2. Highlight the name of the printer in the Printer list box.
3. Click on the Setup button.

The setup dialog box for the selected printer appears.
4. Select Paper Size and Orientation options to match your document.
5. Click on OK to confirm your specification. Click again on OK to accept the Printer Setup.

NOTE: On some printers, you may need to print envelopes in landscape mode.
To print labels or envelopes:

1. Click on the Print button on the control strip or choose the Print... command from the File menu.
The Print dialog box appears.

2. Enter the number of copies you want to print. 
3. Click on OK.

Easy Working Labels! prints an envelope, card, or label.

To print records from the Address Book, you first must use that module to select the records that you 
want printed.

To set up your printer:

1. Select the Printer Setup... command from the File menu.
The Printer Setup dialog box appears.

2. Highlight the name of the printer in the Printer list box.
3. Click on the Setup button.

The setup dialog box for the selected printer appears.
4. Select Paper Size and Orientation options to match your document.
5. Click on OK to confirm your specification. Click again on OK to accept the Printer Setup.

NOTE: On some printers, you may need to print envelopes in landscape mode.
To print labels, cards, or envelopes:

1. Click on the Print button on the control strip or choose the Print... command from the File menu.
The Print dialog box appears.

2. If appropriate, choose the kind of merge operation you want.
This option is gray if you have not selected a database file or the Address Book. You can print all 
the records, a range of record numbers, or only the selected records (if you have previously 



selected a subset of records).
3. Enter the number of copies you want to print.

In a multiple-print job, this is the number of copies per record. Ordinarily you want only one copy;
that is, one copy for each record selected from the database.

4. Printing begins at the label position you indicate in the Print from Label # text box.
5. Click on OK.

The Easy Label Maker prints an envelope or label for each record.

To print labels or envelopes from a database:

1. Display the Print dialog box by using either the control strip button or command from the File 
menu.
The Print dialog box appears.

2. Enter the number of copies that you want to print.
3. If merge field references have been inserted, press the Criteria... command button.

This button is grayed out if no merge fields have been cited. The Merge Criteria dialog box 
appears. Refer to Chapter 7, "The Database," for instructions on filling in the Merge Criteria 
dialog box.
Printing begins at the label position indicated in the Print from Label # text box.

4. Click on OK.
Easy Working Labels! begins to print.

6. The Address Book
The Easy Working Labels! Address Book is a predefined database that contains the type of information 
that is usually kept on rotary file cards. This module is your central source for names, addresses, and 
other information that is related to all your business and personal contacts. You can add, change, and 
delete Address Book information, view the entire Address Book, or look up a particular name.
In addition, the information in your Address Book is instantly available to the Label Maker module for 
use in printing labels, envelopes, and rotary cards. You can also merge data from the Address Book into a
new database file.

This chapter discusses the Address Book window, the menus and commands, and describes how to:

• Change between Card and List view
• Add cards
• Search for a name
• Modify a card
• Delete cards
• Print one or more cards
• Use Address Book data in other modules 

The Address Book is a fixed-format database, which means that you cannot alter the included fields or 
their positions on the record. When you open the Address Book module, Easy Working Labels! displays
the Address Book window in Edit Record (card) view so that you can begin adding new entries or editing
existing cards (records).

To open the Address Book:

1. Start Windows and Easy Working Labels!, if they are not already active.
2. Double-click on the Address Book icon or select the Address Book command from the Window 

menu.



The Address Book becomes the active module, and the Address Book window appears.

View Record — Accesses single card mode where you enter and edit data.
View List — Accesses name list mode to view a list of all records.
Add Record — Allows you to add a record when single card view mode is active. 
Cancel Entry — Cancels any edits on the current entry screen.
First Record — Displays the first record of the Address Book.
Previous Record — Displays the record that immediately precedes the current record.
Next Record — Displays the record that immediately follows the current record.
Last Record — Displays the last record of the Address Book.
Select Record — Marks records for selection in the name list mode.

Each card in the Address Book has text entry boxes, or fields, into which you enter data. Each field has a 
description of what that field should contain.
In addition, each field has a database field name that identifies the field during merge operations. 
Although these database field names never appear in the Address Book, they are the only way other 
modules can identify Address Book fields. During the merge operation, which is discussed later in this 
chapter, you will learn how to use the database field names.
The following table lists the text labels and database field names, and defines the fields' data 

Text Field Name Meaning

Last Name LNAME Person — family name
First FNAME Person — given name
Salutation SALUT Salutation (Mr.,, Mrs.,, Ms.,, Dr.)
Title TITLE Business title
Company COMPANY Company name
Address ADDRESS Street address
City CITY City
State STATE State
Zip ZIP Zip code
Country COUNTRY Country
Work Telephone WkPHONE Daytime phone
Home Telephone HmPHONE Evening phone
Fax/Modem FAX Fax or modem phone
Notes NOTES Comments of any sort 

There are two different ways to view your Address File:

Card View — Displays one card (record) with all its fields and associated text. You must be in Card view
to add or edit a card. 

Easy Working Labels! defaults to this view when you open the Address Book.

List View — Lists all the names included in the Address Book in a scrolling box. You must be in List 
view to select records to include in a merge or print operation.
To change view, select either of the View commands from the View menu, or click on one of the View 
buttons on the control strip.

When you begin, your Address Book has no cards. Your only option is to add a card. After that, you can 
add, delete, or change a card at any time.

To add a card to your Address file:



1. Click on the View Record button to use Card view.
2. If the current record is not blank, click on the New button.
3. Enter the last name.
4. Press TAB or ENTER to move the cursor to the First Name field, and enter the first name.
5. Continue to move through the fields and enter text until you complete all of the applicable fields.
6. Repeat Steps 2 through 5 for each new card.

Easy Working Labels! automatically saves each card in alphabetical order by the data contained in the 
Last Name field when you complete a card or switch to another card.

There are three ways to locate a card in the Address Book:
• Paging through the cards using the navigation buttons.
• Accessing List view to choose a card by name.
• Using the Search command to find a card.

To page through the Address Book:

1. Click on the View Record button to access Card view.
2. Click on one of the navigation buttons to move to a different card.
First Record Button — Displays the first record in the Address Book.
Previous Record Button — Displays the record immediately before the current record.
Next Record Button — Displays the record immediately after the current record.
Last Record Button — Displays the last record in the Address Book.
3. Continue using navigation buttons until you find the card you want.

To choose a record from List View:

1. Click on the View List button to access List view.
2. If the name you want is not displayed, use the scroll bar to bring the desired part of the alphabet 

into view.
3. Double-click on the desired name to display the record information in Card view for editing.

To use the Search command:

1. Click on the View Record button to access Card view.
2. Select the Find... command from the Record menu. 

The Find Entry dialog box appears.
3. Enter text that is unique to the card that you want to find.

For example, if there are two Laurie Smiths in your Address Book, but they work for different 
companies, you might want to search for the company name.

4. Check the Case Sensitive option to search for exact capitalization matches.
For example, if you check this option and you enter LINDA as your search text, Easy Working 
Labels! will locate LINDA, but not Linda.

5. Click on OK.
Easy Working Labels! places the first Address Book record containing the search text on screen.

6. If this is not the record you want, select the Find Next command from the Record menu to locate 
the next instance of the search text.
Easy Working Labels! displays the next matching record on screen.

You can easily update the information contained in a card.

To change a card:

1. Find the card that you want to be change (using any of the methods above), and select the Card 
view.



2. Click in the field that you want to edit, and highlight the text that you want to change (double-
click to highlight the entire field).

3. Enter new information, or modify existing text.
You can use the standard Edit menu commands Copy, Cut, and Paste to move field information 
into your label from any other Easy Working Labels! applications, such as the Database.
As soon as you press TAB or ENTER to advance to the next field, switch to another card, or exit 
Address Book. Your changes are saved automatically.

When cards become outdated or unnecessary, you can quickly remove them from the Address Book. The 
Address Book's delete feature provides an Undelete Record command so that you can recover deleted 
records. If you delete another record or exit Address Book before you recover a deleted record, however, 
the deleted information is lost.

To delete a card:

1. Locate the card you want to remove and access List view.
2. Highlight the record that you want to delete. 
3. Select the Delete Record command from the Record menu.

The selected card is deleted.
4. To recover the deleted record, select the Undelete Record command from the Record menu before

performing another editing action.

You can print a single card, the entire Address Book, or selected cards. All printing is done to the selected
printer that was installed through Windows. To change the printer, select the Printer Setup... command 
from the File menu. For more information on printing and Printer Setup, refer to your Windows 
documentation.

To print a single card:

1. Find the card you want to print (using methods described earlier), and access Card view.
2. Select the Print... command from the File menu.

The Print dialog box appears.
3. Select the Current Record option.
4. Click on OK.

To print the entire file:

1. Select the Print... command from the File menu.
The Print dialog box appears.

2. Select the All Records option.
3. Click on OK. 

To print selected cards:

1. Click on the View List button to access List view.
2. Select a record for printing by highlighting it and clicking on the Select button or choose the 

Select command from the Record menu.
A plus sign (+) appears to the right of the record you select.
To deselect a record, repeat the same procedure.

3. After you select all the records that you want to print, select the Print... command from the File 
menu.
The Print dialog box appears.

4. Select the Selected Records option.
5. Click on OK. 



The data that you save in your Address Book files may be useful in other applications. Some examples of
this include:

Using Easy Working Labels! to print multiple labels or envelopes for mailings.
Exporting data from the Address Book to a database where some or all of the same information is 
needed.

When you print an Easy Working Labels! document, you can use all or some of the cards in the Address
Book file. There are three options:

• Use all cards in the Address Book
• Use a range of cards
• Use selected cards

Using all cards requires no special preparation. To use a range of cards, you have to know the numeric 
position of the cards in the file. For example, if you want to print all the cards in J through L, you would 
have to know the record numbers of the first card in J and the last card in L.
To use selected cards, you must first select the cards you want to use in the form letter. The procedure is 
exactly the same as the way you select cards for printing.

To select records for a print merge:

1. Open the Address Book module.
2. Click on the View List button to access List view.
3. Select a record for printing by highlighting it; then, click on the Select button or choose the Select 

command from the Record menu.
A plus sign (+) appears to the right of the record you have selected.
To deselect a record, repeat the same procedure.

4. When you have selected all the records that you want to use, return to Easy Working Labels!. 

To print labels or envelopes using Address Book data:

1. Open the Label Maker module and load the document.
2. Select the Print... command from the File menu.

The Print Dialog Box appears.
Copies — Enter the number of copies for each record. The default is one (1).
Pages — Specify all or a specific range of pages.
Enable Merge — Check this box if you want to merge Address Book information with the 
document.

3. Click on Criteria... if you want to specify a range of records to merge.
The Merge Criteria dialog box appears.

4. Select the desired merge option.
All — merges all Address Book cards with the form letter.
Range — check this option to define the record numbers included in the print merge. If you select 
this option, enter the start and ending record numbers in the From and To text boxes.

5. Click on OK to accept the Merge Criteria.
The Print dialog box reappears. 

6. Click on OK to perform the print merge.
Label Maker inserts the data and prints a label for each selected card in the Address Book.

The Address Book file is a predefined database from which you can export data into an Easy Working 
Labels! database. Refer to the chapter titled "The Database" for exact instructions on importing data 
from the Address Book. 



7. The Database
The Easy Working Labels! Database is simply a card file that you keep electronically, the computer doing
most of the tedious work that accompanies data management. Sorting cards, rearranging them, moving 
information around to make reports, and many other tasks become quite easy with a database.
A database also can be used for very sophisticated data tracking and management. Not only does it 
organize data, it lets you produce multiple reports that can highlight trends in your data that are not 
apparent from an alphabetic or numeric listing. For example, you can track sales orders in a database by 
entering each sale and its amount along with other information. Later you can produce a report of your 
database showing only those sales that are over $1,000.

This chapter describes how to create and use database files. Specifically, you will learn to:

• Define a database
• Add and edit records
• Change your database definition
• Search through records quickly
• Sort records
• Define custom reports
• Define automatic calculations
• Import, merge, and export data
• Maintain records 

Before we begin to explore how to create and use databases, let's review the terminology of databases, 
which may be unfamiliar to you.

A database file is made up of several parts, only some of which are visible to you as you use the database.
It is important you understand these so you can take advantage of the great flexibility databases give you 
in organizing, sorting, viewing, or printing your data. Each database file is made up of at least four parts: 
Records, Record Layout, Report Layout(s), and an Index.

The information that you save in a database is organized in a manner that is similar to a card file in which
each card has the same set of information. These electronic "cards" are called records. Each record 
contains blanks, known as fields, in which you enter information. In an address file, for example, each 
record represents a single person or contact. That record is broken down into fields such as first name, 
last name, company name, address, city, state, phone number, and so on. Each record can contain as 
many as 128 fields for information entry.

When you start a card file, you first determine what information to collect. This helps you to design the 
format for the cards. You do the same thing with a database by defining a record layout.
The record layout is what appears on the screen when you enter and edit data. You can have only one 
record layout for an individual database file. You can, however, define numerous layouts so that the same
data can be printed in a variety of ways.
A layout for the record layout or for a report layout can include fields, as well as text labels to explain the
data that is entered in the fields. A layout also includes fields for data entry. 
Text labels make the screen presentation of data and data entry more understandable than a collection of 
fields.
When you add a field to a layout, you choose both a data type and amount of input for the field. Each 
field must be assigned one of the following five types:

• Character (up to 254 characters of any kind)
• Numeric (numbers up to 18 numerals)
• Date (dates up to eight numerals from 1/1/1900 to 12/31/1999)
• Logical (a single character that indicates True/False or Yes/No responses) 



• Memo Fields (text up to 32,000 characters)
Sometimes the correct data type may not seem logical. For example, when you want to set up a zip code 
or phone number field, you may think that the information is numeric. Numeric fields ignore leading 
zeros and hyphens, however, which would create problems with zip code and phone number fields.

When you set up a database file, you also decide which item of data or field you want to use for sorting 
the records. This data item is called the index of the file. Your selection determines the order in which 
records are presented to you as you navigate through the database.
For example, a videotape library might be organized using a numbering scheme that you developed. One 
field in the database would contain these numbers; you could then use that field as your index. The 
database will be sorted using that numbering scheme.
In many cases, you also want to sort records based on some other field. With a paper file, you create a 
separate "cross index" file. This is another file that duplicates a small amount of the data in your main 
file, but you keep it in a different order. In the videotape example, you might make a cross reference card 
for the title of each videotape. A card in the cross reference file has only two fields: the title and the film 
type. Because you keep this file in alphabetical order by title, you can look up any title, find the tape 
number, then look up the record in the main file by tape number.
Using a cross reference file is quite tedious on paper, but simple for computers. In fact, the Easy 
Working Labels! Database allows you to create up to three index files, and it treats them all equally. You
don't have to see any of this crossindexing happen at all. You simply decide which index to use, and the 
database behaves as if the data were sorted in order of the indexes.
In effect, your file is sorted three different ways instantly, depending on which index you decide to use. If
you do not choose to use an index, the database uses the record number that is assigned automatically, 
with the oldest records entered being first.

There are two mathematical functions that can be applied to fields. These are advanced features of using 
a database as they further enhance the flexibility to view, organize, or print information entered in the 
database.
Each field can have automatic programming called a field qualifier. The field qualifier is a mathematical 
statement that uses constants, other field names, operators, and functions. It can do one of two things:

• Automatically compute a value for the field based on data in other fields
• Validate data entered in the field to be sure that it meets some requirements 

The first option is demonstrated by a database of inventory records that includes one numeric field that 
gives the value per item (VALEACH), and another showing how many are in stock (ONSTOCK). A third
field for the total value is computed automatically by defining a field qualifier that multiplies those two 
fields.
Field validation is demonstrated by a database of videotapes that contains a field that shows the length in 
minutes (RUNTIME). Since the longest tape can run only 160 minutes, you define a field qualifier to 
verify that the number entered is less than 161.
Another kind of mathematical statement is a criterion. Criteria are logical test conditions used to select 
particular records. For example, you may want a report of only videotapes rated "G" and "PG13." This a 
criterion that uses a field named RATING. The following statement selects only the tapes you want:
(RATING = "G") OR (RATING = "PG13")
You will use criteria statements in database reports to limit records included, and also with Label Maker 
to chose a limited number of records from database files for mail merges. 

The Database module consists of six operating modes. Each mode determines which commands and 
operations are valid. The active mode is displayed on the status bar.

No Database Open Mode — The message "No Database Open" appears on screen and on the status bar. 
This mode appears when you start the Database module or close the current database.
Define Database Mode — Used to define or redefine the database's layout.
Edit Records Mode — Displays a single record in a cardlike format so you can edit existing information 
or add new records. The status bar information tells the number of the current record, the total number of 
active (nondeleted) records in the file, and the total number of records (including those that were deleted, 



but not purged). Access this mode with the View Records button or the Edit Records command on the 
Database menu.
List Mode — Displays all records in list form. Use this primarily to locate and view records.
Define Report Mode — Allows you to define or edit the body of a report.
View Report Mode — Accesses the report format.

Although the Database has six operating modes, most of your time will be spent in Edit Records mode. 
This mode enables you to create new records, edit existing records, and view information. 

To open the Database window:

1. Start Windows and Easy Working Labels!, if they are not already active.
2. Double-click on the Database icon, or select the Database command from the Window menu. 

The Database module becomes the active module, and the Database window appears on the screen.

New Record — Adds a blank record to the database.
First Record — Displays the first record in the database.
Previous Record — Displays the previous record in the database.
Next Record — Displays the next record in the database.
Last Record — Displays the last record in the database.
Create Text — Allows you to create a text label.
Create Field — Allows you to create a field.
Edit Records — Returns to Edit Records mode.
List View — Displays a list of all the records in the database.
Report — Allows you to create and define a report format. 

When the Database module opens, the status bar and a screen message indicate that there is no database 
open. Until you have defined your first database, your only option is to create a new one.

To create a database:

1. Select the New command from the File menu.
The Database module is now in Define Database mode. The Create Text, Create Field, and View 
Records buttons become active, and the Status Bar displays Defining Database.

2. You have two choices:
Start fresh — Use the following procedures to create a custom record layout.
Copy an existing definition — Use the Load Definition... command on the Define menu to read in
the layout of an existing database as a starting point. The Load Definition... command displays a 
dialog box  much like the Open... command  for you to select a database file as your source for the
record layout.

There are several things to consider before beginning a record layout. While you can easily rearrange text
and fields once you have started a layout, you should at least be aware of these issues.
Order of data entry — The logical order in which information will be entered into the database may help
you determine how to format your record layout. For example, you typically want to list a name before 
an address, or you may prefer to enter information last name first, and so on. This also determines the 
order in which the cursor moves from field to field when you press TAB. The cursor will move 
horizontally left to right, then down to the next row, and across again. Fields should be positioned to 
enhance this logical cursor movement.
Number and types of fields — You might want to have separate fields for first and last names to facilitate
sorting, searching, and selection. Similarly, zip code and phone number fields should be entered as 
character fields to avoid losing leading zeros and to allow hyphens. 
Setting and Index — Think about how you might want to control the sorting or indexing of your 
database. You can change the index at any time, but only if you have created appropriate, separate fields.



Memo fields — You can use this to place notes on records or in reports. Memo fields cannot be merged 
with the Label Maker, and they are not included if you export your data.
Grids and Rulers — Setting Grids and Rulers options before defining a database can make placing and 
aligning fields and text labels quick and easy. The Database module can display both horizontal and 
vertical rulers. As you create or move fields, they will snap to the nearest invisible gridline, making 
accurate placement easier.

To use grids and rulers:

1. Select the Grids and Rulers command from the Define menu.
The Grids and Rulers dialog box appears.

2. Check the box for the rulers that you want to view.
The vertical ruler and the horizontal ruler can be enabled and disabled separately.

3. Enter the spacing for the grid that you want to use.
The vertical and horizontal gridlines do not have to have the same spacing. If the spacing is zero, 
there is no gridline for that dimension.

4. Click on OK to accept your changes.

When the rulers are enabled, you can see the position of the cursor numerically. When the grid is 
enabled, fields and text "snap" to the grid for precise alignment. 

In the following sections, we have defined a videotape inventory with the following fields:

Name Type Size

Title Character 38
Rating Character 4
Category Character 20
Runtime Numeric 3 
Comment Character 50 

Text labels define the information that is to be entered into the fields in a database. All text labels are 
printed when you print records.

To define a label:

1. Click on the Text Label button on the control strip.
The cursor changes to an I-beam.

2. Position the cursor where you want the left edge of the text to be positioned. Click the left mouse 
button.
The Define Text dialog box appears.

3. Enter the appropriate text label in the text box.
4. Click on OK.

The label appears on the screen. 

To define a field:

1. Click on the Create Field button on the control strip.
The cursor changes to a crosshair.

2. Position the cursor where you want the upper left corner of the field to be. Click the left mouse 
button.
For the moment, place the cursor to the right of the label you created. You can change the field 
position later.
The Define Field dialog box appears when you click the mouse button.

3. Enter a field name into the Field Name text box, using up to 10 letters and numbers without 



spaces. 
The first sample field is Title.

4. Click in the Field Type list box. Click on the arrow to display the field type options, then click on 
your selection.
The Title field is character data.

5. Click in the Field Size text box and type in the character size of the field.
Title is 38 characters long.

NOTE: Use the Field Qualifier option when entering mathematical statements to perform operations on 
data. A qualifier is not required for a simple database such as our sample. This is an advanced topic, as 
mentioned earlier in the Database Concepts section, and has a detailed description in the "Database 
Operators and Functions" section near the end of this chapter. 

6. Click on OK to accept the field definition and exit the dialog box.

Even though it only has one field so far, you have just defined a record. Continue defining fields and 
labels until you complete the record, as shown in the sample below.

Save your work frequently to record the edits you make to the database definition. You can always return 
to Define Database mode and make further edits to the record layout.

To save your database definition:

1. Check the layout to be sure that it is complete.
2. Click on the Edit Records button.

The Database Definition dialog box appears and asks you if you want to save the definition.
3. Click on Yes to save the edits to your database definition and continue.

Since this is a new database, the Database dialog box appears and you must enter a name. "Video" 
is a good name for the sample. The database name must be no more than eight characters and must
follow the rules for DOS file names.
If you select Cancel, you return to the record layout. If you click on No, you end the database 
definition without recording your work.

4. Click on OK.
The Create Indexes dialog box appears.

5. Select up to three fields as index options by clicking on the arrow next to each list box and making
a selection.
For the sample, use TITLE for the first Index Field Name, RATING for the second, and 
CATEGORY for three. You cannot select logical or memo fields. You can redefine your choices of
index fields by selecting Create Indexes in the Database menu.

NOTE: When creating or sorting by indexes, the program is not case sensitive.

6. Click on OK to accept your selections.

Once you save the record layout, the database switches to Edit Records mode, and you can begin entering
information.

The Database can open a variety of database files, including those created by other application programs,
including WindowWorks database files (.DBF and .WDF) and PFS:First Choice (.FOL) files.

To open an existing database:

1. Select the Open... command from the File menu.
The Database dialog box appears.

2. Select a file from the File Name list box.



If necessary, select a file type from the List Files of Type list box, and use the Directories and 
Drives list boxes to search for files.

3. When you have located the desired file, click on it to place it in the File Name box.
4. Click on OK.

Database opens the file to the Edit Records window.

You are ready to begin entering records or making edits to existing records.

Once you have accepted a record layout definition, regardless of whether you have entered record data, 
you can easily return to Define Database mode and make changes.

To alter a database definition:

You must be in Edit Records mode to select Alter from the Database menu. The Database module 
returns to Define Database mode.

You now have the same options that you had when you first created the database with the New... 
command, except that you begin with the existing data definitions.

To reposition text blocks and fields:

1. Place the mouse cursor on the field or text block that you want to move.
2. Press and hold the left mouse button and drag the block until it is moved to the correct position. 

Then, release the left mouse button.
3. Click on the Edit Records button to save the new definition and return to the Edit Record mode.

The Database Definition dialog box appears and asks you if you want to save the definition. 
Respond as appropriate.

You can position fields and text labels very precisely using the Edit Field... and Edit Text... commands 
from the Define menu. When the appropriate dialog box appears, enter numeric positions for the text 
label or field.

To redefine (or delete) text blocks and fields:

If you are in Edit Record mode, begin by selecting the Alter command from the Database menu.
1. Place the mouse cursor on the field or text block that you want to edit.
2. Double-click the left mouse button.

The Text or Field Definitions dialog box appears.
This is the same dialog box that you used to create the item, except that the Delete button is now 
available if you want to delete the item.

3. Make any changes you want and click on OK (or the Delete button) when you finish.
4. Click on the Edit Records button to save the new definition and return to the Edit Record mode.

The Database Definition dialog box appears and asks you if you want to save the definition. 
Respond as appropriate.

Once your record layout is defined, you can begin to insert information into each record field. When you 
enter Edit Records mode, a blank record appears on screen. 

To enter data:

1. The first field is highlighted, ready for you to begin typing. Enter data and press TAB to go to the 
next field.

2. Continue entering data in the fields. The database automatically saves the record in the database.
3. Click on the New button to place a new blank record on screen, and enter data in the record.



If you created the sample database definition, you can add the following data to the database.

Title Rating Category Runtime Comment 

Terminator PG13 Action 160 Arnold Schwartzenegger as the killer 
robot
Princess Bride G Children 120 Adults and children both like this one
Family Picnic NR Home 12 Home video edited with titles and music
Backdraft R Action 120 Chicago firemen battle a mysterious 
arsonist 

There are five ways to find data in a database file.
• By using the Find Record... command to find a specific record by field.
• By using the Go To Record... command if you know the specific record number.
• By "paging through" each of the records using the navigation buttons to search for information.
• By setting the index to resort records for paging in alphabetical or numeric order.
• By switching to List View mode and scanning the information for all records.

To use the Find Record... command:

1. Select the Find Record... command from the Record menu.
The Find Record dialog box appears.

2. Highlight the field you want to search in the Field list box.
The size of the database determines how long it takes to find a record. If you have a large database
it may require a long search.

3. Enter the text, string, or numeric value that you want to locate in the Field Contents text box.
When you execute Find Record, the Database becomes case sensitive and locates only exact 
matches. If you are unsure of the exact text, you can use wildcards in the Field Contents text box.

Wildcard Easy Working Labels will find:

MA A field that contains "MA" exactly
MA* Any field that begins with "MA"
*MA* Any field that contains "MA" in any part 

4. Click on Find to begin the search.
If a match is found, Easy Working Labels! displays that record.

5. Select the Find Next command from the Record menu to search for another occurrence.

If you are using a large database, you may find it convenient to use the Go To Record... command to 
immediately display a specific record number. In this case, you must know the record number that was 
assigned to the record when it was created. This is one reason why it often is helpful to include the 
original record number in reports. 

To use the Go To Record... command:

1. Select the Go To Record... command from the Record menu.
The Go To Record dialog box appears.

2. Enter the record number in the field.
3. Click on OK to display the record.

To page through the records:

1. Click on one of the navigation buttons to change to a different record.



First Record button — Displays the first record in the database.
Previous Record button — Displays the record immediately before the current record.
Next Record button — Displays the record immediately after the current record.
Last Record button — Displays the last record in the Database.

2. Continue using the navigation buttons until you find the record you want.
Remember, records are ordered and presented according to the indexes that have been set for the 
database file, and which one(s) are active. In the absence of any index, Database uses the arbitrary, 
historical record number that is assigned automatically when the record is created. 

To set the index to resort records for paging:

1. Select the Set Index... command from the Database menu.
The Set Index dialog box appears.

2. Make one of the available fields the active index by clicking on the appropriate field name.
3. Click on OK to apply your selection.

The records now are sorted by that field and will be in alphabetic or numeric order according to 
your choice.

To select List View to find data:

1. Click on the List View button on the control strip.
The Database switches into List View mode.

2. Select the Define List View... command from the Define menu.
The Define List View dialog box appears. 

3. Select from the options to rearrange the fields listed or otherwise order the display.
Remove Last — Removes the last field in the list above. Repeat as necessary to remove fields.
Remove All — Clears the entire list of fields except for the "rec#" (record number) entry so you 
can start your definition fresh.
Add — Adds selected fields in the list box to the display list at the top of the dialog box.
Criteria — Displays the Select Records for List View dialog box, that is identical to the Record 
Selection Criteria dialog box.
If you select Criteria..., the Record Selection Criteria dialog box appears.
The following three options build upon each other. If a criterion is established in the Record 
Selection Criteria text box and you select a record range, only those records that meet the criterion 
in that range appear in List View.
Record Selection Criteria — Enter up to three criteria statements using any fields (except logical 
and memo types). You can enter statements directly, or you can use the drop-down list boxes to 
select field names, operators, and functions.
For example, under fields, click on the arrow and select Title. Under operators, click on the arrow 
and select . Since we are not selecting a function, enter "K*." Thus, Title"K*" will select only 
those records that have a title that is alphabetically higher than K.
Record Selection Range — Enter the numbers of the first and last records that you want to include
in the Start at and End at text boxes. In the Index Field box, select the field on which the database 
sorts. This determines the record order and affects records to be included.
Sort Record by Fields — Define up to three fields and their sorting order. Those records that meet 
the criteria set above (or all records, if nothing is specified above) will be sorted based on the 
field(s), you select.
For example, if you select Title and Ascending in the leftmost field box, Princess Bride will appear
above Terminator in the List View for the established sample.
Done — Saves your selections and displays your database in List View, unless you are in Edit 



Records mode.
Cancel — Restores the list order to its settings before you open this dialog box.
View — Saves your selections and displays your database in List View.

4. Click on Done to return to the mode you were in when you selected the Define List View 
command, or Click on View to switch directly to the List View mode and see the changes.

5. Use the scroll bars to move down or across, as needed, to see all of the data that is presented in the
new List View.

6. Once you have located a record that you want to view, click on the Edit Records button to display 
the full record, or double-click on the record.
You also can print the List View, effectively producing a report on the fly without actually creating
a report layout. To do this, select the Print... command from the File menu.

Operators and functions are used in criteria for selecting records, testing data entered into a field, and 
computing the contents of fields.

Fields contain variable data, but expressions can include constants. Numeric constants are simple 
numbers.

• Character constants are enclosed in double quotation marks.
• Date constants are enclosed in single quotation marks.
• Logical constants are 1 for True/Yes, and 0 for False/No.

You can use these operators on numeric data.
+ Addition
- Subtraction
* Multiplication
/ Division
^ Exponentiation

You can use any of the following functions on a numeric field:
sqrt(x) square root
sgn(x) sign (1 if 0, 1 if , 0 if =0)
abs(x) absolute value (ignore sign)
int(x) round to integer
pct(x) convert percentage (divide by 100) 
sin(x) sine (in radians)
cos(x) cosine (in radians)
tan(x) tangent (in radians)
asin(x) arcsine (in radians)
acos(x) arccosine (in radians)
atan(x) arctangent (in radians)
log(x) common logarithm (base 10)
ln(x) natural logarithm (base e)
exp(x) exponential (e raised to value)
mod(x,y) modulus (remainder of x/y)
round(x,y) round x to y decimal places

You can use comparison operators to compare both numbers and strings by alphabetical order/ASCII 
code value. The comparison functions produce logical values (true or false). A logical value can be 
printed in a report in two different formats. Within the definition for a Field Definition box, you can 
select either logical TRUE or FALSE or logical YES or NO.

=, <> Equal and unequal test to see if strings and numbers are exactly equal. String 
comparisons are<M> case sensitive. For example: Robert = robert is false; 4 4.0 is false.

<, <=, >, >= Less than, less than or equal to, greater than, and greater than or equal to are standard 
comparison functions for numbers and strings. For example: 5 produces a value of true.



val Converts a string into a number if it is valid.
string Converts numeric input to be recognized as a string.
chr Converts an ASCII code to the appropriate character.
asc Converts a character to the corresponding ASCII code.

len Computes the length of string in characters.
lower Converts the string to all lower-case.
upper Converts the string to all upper-case. 
space Produces up to a maximum of 254 blank spaces in a string.
at(x,y) Checks if string x is in y, returning the numeric position if there is a match or 0 

if it is not contained.
trim Eliminates trailing spaces from the selected string.
Concatenation Adds two strings together, allowing you to collapse the number of standard 

spaces in a report output. For example: enter the definition (xfield + " " + 
yfield) to achieve one space between the two fields.

These functions are based on the Julian date (1/1/1990) as the first date of the decade and is used 
internally by the program.

This function takes three numeric arguments (day, month, and year) that specify a date and returns the 
number of days that elapsed from January 1, 1990 to that date. For example: date (1,30,1990) produces a 
value of 29. 

These three functions comprise the inverse of the date function. Given a number that was calculated 
using the date function, day returns the dayofthemonth, month returns the monthoftheyear, and year 
returns the year. For example: year (3660) produces a value of 10 because 3,660 days is just over 10 
years.

There are two reserved field names that are preset to perform particular functions without input.

Using this name in a field definition results in a random value between 0 and 1, which is different every 
time it is printed. For example: rand might produce 0.432345 or 0.829807 or 0.123456.

Using this variable always results in the value of pi (~3.14159). For example: 2*pi produces a value of 
6.28318.

These operators can be used to combine, compare, or calculate selected criteria. They are often enclosed 
in parentheses to clearly differentiate complicated selections.

x AND y True only if both x and y are true.
x OR y True if either x or y is true.
NOT x True only if x is false.
IF(x,y,z) If x = true, y is result, otherwise, z is result.

When you receive the message "No records meet criteria," check the following:
• That you have entered an exact match of the text string that you want to check. For example, if 

you have Lastname = "jones," the database is searching for a small "j." Change the statement to 
Lastname = "Jones." 

• That the proper syntax has been used in the statement. Characters must be enclosed in double 
quotes (" "), dates must be enclosed in single quotes (' '), but numbers do not need delimiters.

• That the field name is exact. For example, if you enter Lastname = "Jones," but the field's name is 
actually LNAME, you must change the statement to LNAME = "Jones."

As your database expands to hold more information, it becomes more difficult to extract specific 



information. Data management is an important task, and for efficient usage it should be attended to 
diligently. For example, searching through each record to locate those members born in February is 
simple when your database contains 10 records, but it becomes an awesome task when the database 
grows to 100 records. Reports allow you to view and print a list of all members born in February.
Basically, reports allow you to print and view selected information in a user-specified format. You can 
create multiple report templates and produce fresh results at any time to reflect updates in your data. 
Each template is easily edited to produce the results you need.

You define a report layout in much the same manner as you defined the database record layout. In fact, 
the default report layout is the one you defined as the record layout.

To create a customized report:

1. Click on the Report Button on the control strip, or select the Report... command from the 
Database menu.
The Report dialog box appears.

2. Click on the New... button.
3. Enter a name for this report in the Report Name text box and click on OK or press ENTER.
4. Click on the Body... button.
5. Just as you edited the record layout in Database Definition mode, you can add, move and delete 

fields or text labels using the same functions in the report layout.
6. Place the mouse cursor on the field or text block that you want to move.
7. Press and hold the left mouse button while dragging the block until it block is moved to the correct

position. Then, release the left mouse button.
8. Click on Create a Field button from the control strip and place the crosshair cursor to the right of 

runtime. Click for the placement of this new field.
Use the down arrow to the right of the Quick Define box for a field definition. The Quick Define 
option in the Report Field dialog box allows you to select a data field and place it on the report in 
its standard format.
In this dialog box you can also change the formatting for your information, e.g. select Format to 
change from or to percentages, $#,##0.00 or 0.000.; select Justification to move information left, 
right, centered, or justified; and select Width to determine the number of characters or digits per 
field.
With this new field, let's illustrate an additional feature when creating reports, which is the ability 
to create fields that combine data in existing fields. Thus, you can multiply the data in two fields to
calculate a value. When you create a field like this, you must assign it a new name and begin the 
Field Definition with an equals sign. For example, in Field Definition, enter =Runtime*2 to find 
the total time for any two movies in your database. Enter general in Format, and 5 in Width. When
you finish, click on OK.
A user's most common application of this is in recombining first and last names, for example, for a
more effective and attractive display in a report. The latter is called concatenating fields. You 
create a concatenated field simply by writing a mathematical-like expression in the Define Report 
Field dialog box. The fields that you want to concatenate must all be of the same data type 
(numeric, character, date). 
Easy Working Labels! is very logical and exact about the way it handles the data in the fields. It 
drops any blank spaces and combines the data in the fields right up against each other. So, to put in
spaces, commas, or other text, you must make it part of the expression. This text must be 
surrounded by quotation marks. The following shows some examples:

Expression Result

LASTNAME+","+FIRSTNAME Smith, Mary
DOB+" "+DOE+" "+DOT 10156  27 88 31391
CITY+","+STATE+"  "+ZIP Boston, MA 02110 



9. Click on the Create Text Label button on the control strip.
The cursor changes to an I-beam.

10. Place the I-beam in the header area. The header appears at the top of each page with the records 
appearing below it. It is printed as defined in the Body.
You can put only text labels (no fields) in the header.

11. Enter text and numeric summary fields in the footer.
Summary fields show the sum of all reported records, rather than the data from any one record. 
Only numeric fields can be used to define summary fields.

12. Once you have defined all the text and fields for the body of the report, click on the Edit Records 
button on the control strip. You are prompted to save the report definition.

13. Click on Yes to save the report definition and continue.
The Database Report dialog box reappears.

14. Click on the other buttons and make appropriate selections to finish your report definition.
Layout... button — Displays the Page Setup dialog box for you to make adjustments in the current
setup. 
Report Layout — Contains options for Horiz. Spacing and Vert. Spacing that is used to control 
record positioning in reports. The Horiz. Spacing is used to set space between multiple columns in 
reports, if your layout and data field sizes will allow it. To print a multicolumn report, the largest 
field plus the horizontal space between records must fit within the margins you set. If Easy 
Working Labels! cannot fit the information across the page, it creates only as many columns as it 
can.
Title... button — Displays the Report Title dialog box for you to enter a title for the first page of 
the report. Do not press ENTER to type multiple lines in the Report Title text box as this activates 
the Cancel button. Press CTRL+ENTER to move to the next line.
Character... button — Displays the Character dialog box, allowing you to select character 
attributes. Select a font and point size from the list boxes. You can assign bold, italic, and 
underline formatting options from the Font Style list box.

NOTE: Database supports fonts only in Report mode, and can use only one font per report.

Criteria... button — Displays the Record Selection dialog box that lets you select records for a 
report. You can write criteria statements to select records, and/or limit the selection to a range of 
records. Finally, you can use this dialog box to set sorting order for the records in your report. 
Record Selection Criteria — Enter up to three criteria statements using any fields (except logical 
and memo). You can either enter statements directly, or use the drop-down list boxes to select field
names, operators, and functions.
Record Selection Range — Enter the numbers of the first and last records that you want to include
in the Start at and End at text boxes. In the Index Field box, select the field on which the database 
sorts. This determines the record order and affects which records to include.
Sort Record by Fields — Define up to three fields and their sorting order. Those records that meet 
the criteria set above (or all records if nothing is specified above) will be sorted based on the 
field(s) that you select.

NOTE: If no records meet your selection criteria, you will receive an error message when you click on 
the View... or Print... buttons.

When you print or view the report, the sort order selections override the index selected for the 
database. The other fields are not necessary unless you want to print only a certain range of 
records, or only those that match specific selection criteria.

15. Click on OK.
The Define Report dialog box reappears.

16. Click on the View button.
The report appears on screen. 
You can use the scroll bars to see the entire report.

17. Click on the Report button.
The Database Report dialog box returns.



18. Click OK.
The report definition is accepted.

You can change your report definition at any time, using the Report button or the Report... command on 
the Database menu. It is the same as creating a new report, except that you begin by selecting an existing
report under Report Name.

Each database that you define can have many different reports. For the sample Video database, you might
define reports sorted by title, by category, and by rating. The three different index fields and the multiple 
criteria for record selection give you powerful options for organizing your data into meaningful reports.

To view a report:

1. Select the Report... command from the Database menu.
The Database Report dialog box appears.

2. Select a report template that you want to view from the list.
3. Click on the View button.

The report is displayed on screen for you to view.
4. Click on the Reports button to return to the Report dialog box.

Click on OK to return to Edit Records mode. 

To print a report:

1. Select the Print... command from the File menu.
The Print Report dialog box appears.

2. Select a report from the list by clicking on the report name that you want.
3. Click on Print.

The report is sent to the printer.

You can also use the Print button in the Database Report dialog box to print reports.

The Easy Working Labels! Database has two commands to let you import data that was exported from 
another database or that was created as comma-separated value (CSV). You can also merge information 
with an existing Easy Working Labels! database file.
Use the Import... command on the Database menu to open CSV files. These consist of lines of ASCII 
character data with one record per line and commas separating the fields to act as delimiters (dividers). In
addition, the data must be surrounded by quotation marks. Easy Working Labels! reads the delimiters to
determine where the fields begin and end. Each line (ended by a paragraph return) in the ASCII file 
becomes a record. 
Before you import data, you must make sure that the database file you plan to use has enough fields to 
hold the information. The fields in your record layout should also match the information being imported. 
That is, you should set up numeric fields for numeric information and text fields for text information. The
information for each record will flow into fields left to right from the upper left. Of course, you can 
redefine fields, add labels, and reposition fields and labels after the import is complete.
After you import data, you might want to combine it with another existing database. First, you must 
make sure the two databases have matching or compatible fields. For example, you might import an 
address list and combine it with one you already have. Here, you use the Merge... command on the 
Database menu, especially if the field names and definitions are slightly different (that is, one uses 
ZCODE and the other uses ZIPC).

To merge records from another database:

1. Open the database into which you want to merge records from another database.
2. Select the Merge... command on the Database menu.

The Merge Database dialog box appears.



3. Select the type of file from the List Files of Type drop-down list box.
Use the directory and drive selections to the right, if necessary. The available files of the selected 
type appear in the Files list box.

4. Select the desired database file from the list by clicking on it.
5. Click on OK. 

If the selected database has field definitions that are identical to your current database, all the 
records in the selected database are added to your current database.
If the field definitions are different, the Merge dialog box appears.

6. The MATCH name is the name of a field from the selected database. Below it is a list of fields in 
your current database.
You must select a matching field in the current record layout, or NONE. If you select a matching 
field, the two must be of the same type, size, and so on. If you select NONE, the data from the 
MATCH field in the selected database is ignored and is not merged into the current database.

7. Click on OK.
The next field appears.
Repeat Step 6 until all fields have been assigned. After the last field is assigned, the Set Merge 
Key dialog box appears.

8. Select the field you want to use as the index when the new records are merged.
This procedure eliminates duplication of records.
You can select Record # to merge without using an index. If Record # is selected as the merge key,
records from the selected database will be appended to the current database. If you select a field as
the merge key, records from the two databases with matching data in that field will be combined in
the current database.

9. Click on OK.
The new records are created from the matching fields and merged into the current database. 

The data that you maintain in your database may be useful in other applications. In fact, you can create a 
file that can be used by many applications, even those that are not part of Easy Working Labels!. This 
kind of file is called a "comma-separated value" file, or a ".CSV" file. It consists of lines of ASCII 
character data with one record per line and commas separating the fields.
The Export... command on the Database menu creates such a file. As an example, the sample Video 
database could produce a .CSV file with records that look like the following:
"Terminator","PG13","Action",160,"Arnold Schwartzenegger as the killer robot"
"Princess Bride","G","Children",120,"Adults and children both like this one"
"Family Picnic","NR","Home",12,"Home video edited with titles and music"
"Backdraft","R","Action",120,"Chicago firemen battle a mysterious arsonist"
The data in this .CSV file is then available to any application that can read such a file.

To export records from a database file:

1. Open the database where you want to export records.
2. Select the Export... command on the Database menu.

The Records Criteria Selection dialog box appears.
3. Make selections using the various functions in this dialog box. If you make no selections, all 

records in the database will be exported.
This is identical to the steps used to select records with a custom report or used in finding data. 
You can select a subset of records and/or sort them for export. For more information, refer to the 
section "Defining Reports" earlier in this chapter.

4. Click on OK.
The Export Database... dialog box appears.

5. Enter a name for the export data in the File Name text box. The default filename extension is .CSV
and will be added to the name that you enter.
Also, if necessary, use the Drives and Directories list boxes to determine the storage location for 
the file.

6. Click on OK to save the file for use by other programs.



Now, you can use this data in other Easy Working Labels! modules or with other programs that can 
open CSV or ASCII files.

You may want to delete one or more records from your database. For example, after your database gets 
very large, you may want to remove outdated records (that is, inventory items no longer stocked, 
employees who have left the company more than two years ago). Taking up less memory will help all 
operations of your database work faster.
Deleting records from the database is a two-step process. First, you "remove" records. This maintains 
records as part of the database, but makes them inactive. You can restore these inactive records to the 
database, if needed, using the Unremove function. To completely delete the records from the database, 
use the Purge command. You must be in the Edit Records mode to use either command to remove 
records.
You can remove and restore individual records or all records that match certain criteria.

To remove records from a database file:

1. Open the database from which you want to remove records.
2. Select either the Remove Record or Remove Records... command from the Record menu.

If you chose the single command, the Delete Record dialog box appears asking you to confirm that
you wish to delete the current record.
If you select the multiple command, the Records Criteria Selection dialog box appears. This is 
identical to the one used with several other commands (see the information on "Export," "Finding 
Data," and "Creating a Custom Report" earlier in this chapter). 

3. Click on Yes or OK, depending on which operation you are performing.
No or Cancel returns you to the database without deleting a record.

Removed records do not show up in list view, in reports, or when you page through your database. To 
unremove records, use the following procedure.

To unremove records from a database file:

1. Open the database that contains the removed record(s) that you want to restore.
2. Select the Unremove Records... command from the Record menu.

The Records Criteria Selection dialog box appears. This is identical to the one that is used with 
several other commands, including the Remove Records... command. Make the appropriate 
selections. If you make no entries, all removed records will be restored.

3. Click on OK to unremove, or select cancel to return to the database without restoring any removed
records.

Removed records are still part of your database at this point. The status bar shows the total number of 
records in your database and the number of active records. The difference is the removed records. Once 
you use the Purge command, these numbers will be identical.

To purge removed records from a database file:

1. Open the database that contains the removed record(s) that you want to delete.
2. Select the Purge... command from the Database menu.

The Purge Database dialog box appears.
Remember that once records are purged, they cannot be restored.

3. Click on OK to remove those records, or click on Cancel to return to the database without deleting
removed records.
After using Purge, the number of active records will equal the number of total records. 




